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Abstract: Building Information Modeling (BIM) is an Industry 4.0 methodology that is increasingly
used in the domain of Architecture, Engineering, and Construction (AEC). BIM emerges as a new
methodology, one that is more collaborative and based on parametric three-Dimensional (3D) models,
centralizing different types of information of a geometric, physical, and economic nature. The purpose
of this paper is to analyze the application of the BIM methodology to a rail track rehabilitation case
study using a geotextile and geogrid in the ballast layer base. The creation of the 3D and 4D BIM
models was performed using various BIM-based tools, which made it possible to achieve the spatial
and parametric representation of the rail track and the simulation of the main construction tasks.
A new BIM object pertaining to the rail track was created. This paper describes the procedures
applied in achieving the BIM models, the limitations involved, and the interoperability between the
BIM tools. Additionally, the potential for information extraction with respect to the infrastructure
design, construction, and operation, e.g., planning and scheduling, quantities, graphic outputs, and
track geometry quality, was demonstrated. It was concluded that the BIM methodology was viable
and could be implemented with benefits, despite certain difficulties and limitations, which emphasize
the need for further developments.
Keywords: BIM; railway; rehabilitation; geogrid; geotextile

1. Introduction
In the context of Industry 4.0, Building Information Modeling (BIM) is a powerful methodology,
which has been implemented with great success in the domain of Architecture, Engineering, and
Construction (AEC) [1–3]. Indeed, the construction industry has been working intensively on the
implementation of the BIM methodology in several segments [4–6]. BIM is a collaborative work concept,
strongly based on technological advances in computation. BIM tools enable the development of
building projects during their lifecycle, including the design, construction, maintenance, management,
and demolition phases. However, it is as yet hardly ever used in the transport infrastructure sector
(roads, railways, bridges, tunnels, airports, and ports) [7–12]. It is important to develop the BIM-related
software for the field of transport infrastructures and to encourage the implementation of this
methodology in companies in the sector [13–15]. Taking into consideration that the global railway
industry market is showing solid growth [16], there will be unquestionable interest in the application
of BIM in the particular case of railway infrastructure [13,16–29].
Although only a few case studies have been reported in the literature, there is growing interest in
the applicability of BIM to the transport infrastructure sector. Two cases of road projects were found
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in Australia and Shanghai [30]. These cases describe: the development of the project and simulation
planned with a certain number of BIM tools; the elaboration of a network-based interface for the BIM
model; integration of BIM with GIS; the tracking and updating of the development of the BIM model;
the integration of BIM with a laser scanning device; and the printing of the 3D model.
As argued by Bensalah et al. [9,31], the advantages and benefits of the integration of BIM in rail
projects are considerable, for example: cost control; decision-making support; reduction in design
errors; detection of interface problems; improvement of visual perception; prefabrication support;
maintenance planning support; and infrastructure management. Shin et al. [32] have also pointed out
the financial benefits that BIM can bring to a real project.
However, interoperability remains a major problem in horizontal infrastructures due to the lack
of standardized data. BuildingSMART, an international organization that develops and implements
BIM standards, has already commenced work on creating data standards for roads, railways, bridges,
and tunnels, which can improve interoperability and integration, based on different objects, alignment,
and GIS models [5,25,32,33].
Considering the analyses of the interoperability capacity between software and the universal data
format of data, Industry Foundation Classes (IFC) became essential. The IFC standard was created to
allow for the sharing of complete and accurate models among various stakeholders, regardless of the
applications they use, to ensure efficient exchange of information throughout the process. Recently,
there have been significant advances focused on the creation of ifcObjects [34] concerning rail objects
(e.g., track, subgrade, tunnels, or viaducts). In the present study, the 3D modeler software, most
frequently used in infrastructures, namely Civil 3D® and InfraWorks®, was adopted in the process of
modeling the considered study case. Both models were later transposed to Revit®, using the respective
ifc model. However, it was found that the result of the transposition of both ifc models to Revit was
seriously inefficient, and as such, a complete BIM model was created within Revit. In addition the
interoperability between Civil 3D® and Revit® was also analyzed in terms of the terrain modeling,
using also the ifc format. As far as the actual level of BIM implementation in transport infrastructures
is concerned [7,11], further demonstrations are desirable in order to stimulate the development of the
BIM methodology and its acceptance by the companies involved in planning, design, construction,
and maintenance.
The main objective of the proposed study is to analyze the current capacity of BIM tools, when
used in the field of railway infrastructure. With this purpose, a case study concerning the rehabilitation
of a railway segment was considered, having applied various software, in order to assess the benefits
and limitations inherent in the process. The paper describes the three-Dimensional (3D) modeling
of the project in two BIM software programs and, additionally, the four-Dimensional (4D) modeling
using another BIM viewer. Tests for interoperability were carried out before the use of the various
BIM-based tools. The capacity for extracting information that could be used for infrastructure design,
construction, and maintenance was also explored. The findings showed that there is still a huge
technological inability in this field.
2. Research Methodology
2.1. Case Study Description
A 35 km-long section of railway infrastructure in Portugal was rehabilitated in 2016. This section
was characterized by intense and mixed rail traffic (passengers and cargo). The rail track ballast in this
section was renewed using a combination of a composite of triaxial geogrid and non-woven geotextile
in the base. In general, geosynthetics find application in a range of functions in the rehabilitation
of existing rail tracks: separation, reinforcement, drainage, and filtration. In this case study, the
application of the geotextile had the function of separation and filtration, and the geogrid served to
stabilize the ballast layer in order to reduce the lateral movements of the ballast particles. Figure 1
presents a cross-section of the rehabilitated rail track, indicating the terminology adopted in this paper.
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Figure 1. Cross-section of the rehabilitated rail track (adapted from Neves et al. [35]).
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Figure 4. 3D modeling of the case study: (a) 3D model of the box culvert; and (b) general 3D model.
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The subgrade, sub-ballast, and ballast layers completed the 3D model of the basic rail track
The subgrade, sub-ballast, and ballast layers completed the 3D model of the basic rail track
infrastructure and superstructure components. These elements were created through the Structure tab,
infrastructure and superstructure components. These elements were created through the Structure
Foundation panel, and Slab command. The corresponding properties were the layer thickness and the
tab, Foundation panel, and Slab command. The corresponding properties were the layer thickness
material: sand and gravel in the case of subgrade and sub-ballast/ballast layers, respectively. By way
and the material: sand and gravel in the case of subgrade and sub-ballast/ballast layers, respectively.
of example, the subgrade was modeled as a slab with dimensions of 12.0 × 25.6 × 0.45 m3 . For the
By way of example, the subgrade was modeled as a slab with dimensions of 12.0 × 25.6 × 0.45 m3. For
geotextile and geogrid components, the procedure was similar: the thickness was 5.4 mm (arbitrated
the geotextile and geogrid components, the procedure was similar: the thickness was 5.4 mm
value), and a new material, polypropylene, was created, with the appropriate thermal and mechanical
(arbitrated value), and a new material, polypropylene, was created, with the appropriate thermal
properties, in addition to other product information (e.g., manufacturer and model).
and mechanical properties, in addition to other product information (e.g., manufacturer and model).
Finally, the drainage elements were included in the 3D model, using the Systems tab, Plumbing &
Finally, the drainage elements were included in the 3D model, using the Systems tab, Plumbing
Piping panel, and Pipe command. Two identical pipes, 25.68 m long and 400 mm in diameter, were
& Piping panel, and Pipe command. Two identical pipes, 25.68 m long and 400 mm in diameter, were
placed in a lateral position to the foundation layer.
placed in a lateral position to the foundation layer.
Figure 6 represents the 3D model of the complete rail track including drainage: a perspective
Figure 6 represents the 3D model of the complete rail track including drainage: a perspective
representation of the global 3D model (Figure 6a); a plan representation of the model (Figure 6b); and a
representation of the global 3D model (Figure 6a); a plan representation of the model (Figure 6b);
representation of the cross-section of the total rail track structure and lateral drainage pipes (Figure 6c).
and a representation of the cross-section of the total rail track structure and lateral drainage pipes
The interoperability between Civil 3D® and Revit® was also analyzed in terms of the terrain
(Figure 6c).
modeling. To import the terrain model, the Import CAD command was selected in the Import panel of
The interoperability between Civil 3D® and Revit® was also analyzed in terms of the terrain
the Insert tab. Then, the terrain surface was optimized using the Toposurface command in the Model Site
modeling. To import the terrain model, the Import CAD command was selected in the Import panel of
panel, Massing & Site tab. In a new tab, the Create command from Import was selected. Figure 7 shows
the Insert tab. Then, the terrain surface was optimized using the Toposurface command in the Model
the final terrain model that was obtained: plan view (Figure 7a) and longitudinal profile (Figure 7b).
Site panel, Massing & Site tab. In a new tab, the Create command from Import was selected. Figure 7
shows the final terrain model that was obtained: plan view (Figure 7a) and longitudinal profile
(Figure 7b).
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Seven sets were created to illustrate the different construction phases: existing rail track;
ballast tamping; and final track tamping. Each set was created by selecting the components of the
replacement of track; removal of ballast; substructure; application of geotextile and geogrid; new ballast
geometric model that correspond to that phase. Subsequently, construction tasks were added,
tamping; and final track tamping. Each set was created by selecting the components of the geometric
including the planned beginning and end dates. In order to create the construction sequence, the
model that correspond to that phase. Subsequently, construction tasks were added, including the
TimeLiner command was used in the Home tab and Tools panel. The construction tasks were
planned beginning and end dates. In order to create the construction sequence, the TimeLiner command
manually introduced into the schedule plan. Each of the various sets was allocated to its respective
was used in the Home tab and Tools panel. The construction tasks were manually introduced into the
task.
schedule plan. Each of the various sets was allocated to its respective task.
A Gantt chart, concerning the rehabilitation of the rail track segment, was established directly
A Gantt chart, concerning the rehabilitation of the rail track segment, was established directly
within the Navisworks®. Using the capacity of this BIM viewer, each task was linked to the
within the Navisworks®. Using the capacity of this BIM viewer, each task was linked to the
correspondent construction component (ballast, substructure, geotextile, and geogrid). To
correspondent construction component (ballast, substructure, geotextile, and geogrid). To accomplish
accomplish this operation, the BIM model was created in a way that allowed the representation of
this operation, the BIM model was created in a way that allowed the representation of each construction
each construction step. As such, it was possible to establish adequate links between geometric
step. As such, it was possible to establish adequate links between geometric construction phases,
construction phases, representing the physical construction progress of the rail track rehabilitation,
representing
as illustratedthe
in physical
Figure 8.construction progress of the rail track rehabilitation, as illustrated in Figure 8.

Figure 8. Interface of Navisworks®: generation of the 4D BIM model.
Figure 8. Interface of Navisworks®: generation of the 4D BIM model.
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(c) removal of ballast; (d) substructure; € application of geotextile and geogrid; (f) new ballast tamping;
tamping; (g) final track tamping; and (h) rehabilitated rail track. The elements represented in green
(g) final track tamping; and (h) rehabilitated rail track. The elements represented in green were the
were the object of construction during the task, and the elements in red correspond to a removal or
object of construction during the task, and the elements in red correspond to a removal or demolition
demolition process as part of the task. The two tasks, “existing rail track” and “substructure”, were
process as part of the task. The two tasks, “existing rail track” and “substructure”, were not real, but
not real, but they were included with the aim of obtaining a more realistic simulation of the
they were included with the aim of obtaining a more realistic simulation of the construction phases.
construction phases. The simulation of the different tasks planned for the rail track rehabilitation
The simulation of the different tasks planned for the rail track rehabilitation was obtained through the
was obtained through the Simulate tab of the TimeLiner command.
Simulate tab of the TimeLiner command.
4. Discussion
Interoperability between systems plays a very important role in the BIM methodology. In
Figure 3, the links between BIM software packages represent the interoperability analyzed in the
case study. As already stated, difficulties were identified in terms of interoperability between some
systems. In some cases, interoperability was even impossible. Taking into consideration that the
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4. Discussion
The creation of 3D models was always possible, although with certain limitations, because
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the modeling
wouldsystems
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Civil 3D®.
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that thisInprogram
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Figure 3,
was not the most suitable for the BIM methodology. Whilst Civil 3D® allowed for the creation of 3D
the links between BIM software packages represent the interoperability analyzed in the case study.
representations quite correctly, the generated models were still based on lines and surfaces, as with
As already stated, difficulties were identified in terms of interoperability between some systems.
the traditional AutoCAD 2D® software. This situation introduced interoperability issues, which
In some cases, interoperability was even impossible. Taking into consideration that the programs used
have restricted the process for the definition of 4D models. The interoperability between the Revit®
in the case study analyses were all from Autodesk, interoperability seemed to be guaranteed; but this
and Navisworks® software packages facilitated the process of creating the tasks associated with the
could not be confirmed.
case study, with respect to the 4D modeling.
The creation of 3D models was always possible, although with certain limitations, because initially,
In BIM, it is possible to use tools that allow for extraction of a range of information from the
the modeling would be carried out only in Civil 3D®. We later confirmed that this program was
models created. One of the most important components of a project is the drawing outputs, and it is
not the most suitable for the BIM methodology. Whilst Civil 3D® allowed for the creation of 3D
representations quite correctly, the generated models were still based on lines and surfaces, as with
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the traditional AutoCAD 2D® software. This situation introduced interoperability issues, which have
restricted the process for the definition of 4D models. The interoperability between the Revit® and
Navisworks® software packages facilitated the process of creating the tasks associated with the case
study, with respect to the 4D modeling.
In BIM, it is possible to use tools that allow for extraction of a range of information from the
Infrastructures
2019,
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a fundamental requirement that the designer can easily update them when changes and adjustments
made to the project. Figure 10 presents the graphic representation of the horizontal view (Figure 10a)
are made to the project. Figure 10 presents the graphic representation of the horizontal view
and longitudinal profile (Figure 10b) of the rail track obtained from Civil 3D®. To obtain a drawing,
(Figure 10a) and longitudinal profile (Figure 10b) of the rail track obtained from Civil 3D®. To obtain
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and sub-ballast, the surface areas of geotextile and geogrid, and also the volumes for earthworks
(landfills and excavations). It was likewise possible to extract information on rails, sleepers, and
drainage elements. The sole limitation was the impossibility of quantifying the sleepers and rails
because they were generated as a global parameter in Revit®, and not individually.
To ensure adequate and safe rail track behavior, monitoring of the quality of the construction
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sub-ballast, the surface areas of geotextile and geogrid, and also the volumes for earthworks (landfills
and excavations). It was likewise possible to extract information on rails, sleepers, and drainage
elements. The sole limitation was the impossibility of quantifying the sleepers and rails because they
were generated as a global parameter in Revit®, and not individually.
To ensure adequate and safe rail track behavior, monitoring of the quality of the construction
and throughout the lifecycle of the railway infrastructure is crucial. Inspections are carried out to
monitor the track condition. According to the EN 13848-1 standard, the main track geometric quality
parameters are longitudinal leveling, transversal leveling, alignment, gauge, and twist. In Civil 3D®, it
was only possible to control two geometric parameters: the gauge and transversal leveling. Further
development is needed so that this very important functionality can be fully implemented in the
BIM methodology.
Finally, the 4D model created in Navisworks® was very useful for producing flow and Gantt
charts related to the planning and scheduling of activities.
The present work is focused, mainly, on the rehabilitation of a segment of railroad and not on
obtaining information concerning the inspection or irregularities found in specific points along the
track. However, as a complement to the present study, the inspection and control of the geometry is a
perspective of great interest, to be developed in future work.
5. Conclusions
Major efforts are currently being made towards achieving a more generalized implementation of
the BIM methodology in the domain of transport infrastructures, beyond specific components, e.g.,
tunnels, viaducts, and bridges. The aim of this paper was to contribute to this main goal through the
demonstration of an application to a rail track rehabilitation case study.
The application of the BIM methodology consisted of three phases: (1) creation of the project
model (3D); (2) planning and scheduling of the construction process (4D); and (3) extraction of diverse
model information. The objectives of these phases were achieved in general using different software
packages. The Civil 3D® and Revit® packages proved suitable for 3D modeling, including the rail
track, drainage, and catenary systems. Interoperability between these tools was analyzed. However,
the total integration into Revit® of the 3D model created by Civil 3D® was unsuccessful because most
of the elements were not recognized. Based on the integration of two rail track component families
existing in the BIM Library, a new Revit® family was created in order to represent the complete
rail track. The Navisworks® program was used to create the 4D model. Seven sets were created to
illustrate the different construction phases: existing rail track; replacement of track; removal of ballast;
substructure; application of geotextile and geogrid; new ballast tamping; and final track tamping.
It was also possible to establishing adequate links between geometric constructions, representing the
physical construction progress. The interoperability between the Revit® and Navisworks® packages
facilitated the process of creating the tasks associated with the case study, regarding the 4D modeling.
BIM tools allowed for extraction of diverse information from the created models: planning and
scheduling; quantities of materials; graphic outputs; and track geometry quality. This information is
useful for the design, construction, and exploration of transport infrastructure.
In the domain of transport infrastructure systems, the railways present specificities and complexity
that confer to BIM implementation a greater interest and importance. The highest safety exigencies
of the railway operation (e.g., high speed train) require more frequent monitoring and maintenance
operations. Additionally, the complexity of railway components and systems (infrastructure and
vehicles) requires better tools for data analysis and processing. In this sense, BIM will be a useful
methodology with enormous technical, economic, and environmental advantages along the railway
infrastructure lifecycle. The application of BIM-based tools to the case study described in this paper has
demonstrated that, in spite of certain difficulties and limitations, the methodology has great potential
and should be explored further.
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For the future development of BIM implementation in the domain of transport infrastructures,
advancement of the development of families specific to transport infrastructures is recommended,
particularly in Revit®, so that projects can be modeled more easily and also be more complete and
realistic. Another important recommendation is the integration in the BIM methodology of an adequate
track inspection system that includes all the usual geometric parameters, so that maintenance planning
associated with quality control inspection tests can be integrated. It is also believed that the reported
issues on the interoperability between BIM tools will be overcome in the short term, taking into account
the current and foreseeable evolution of the digital systems.
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